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ANALYSIS OF A PLATE WITH STRESS CONCENTRATIONS 

Instructor: Professor James Sherwood 

Author: Dimitri Soteropoulos 

Programs Utilized: Abaqus/CAE 6.11-2 

Problem Description: 

This tutorial illustrates the effects of various stress concentrations on a plate. Three different stress 

concentrations are incorporated into the geometry of and aluminum plate: a hole, fillets, and a crack. 

The mesh of the plate is designed and refined to fit the conditions of the geometry.  

 

Creating the Model Geometry 

 Go to the Start Menu and open Abaqus/CAE 

 You may be prompted with an Abaqus/CAE 6.11-2 Start Session dialog box (Figure 1). Close this 

box by clicking the X in the top right hand corner.  

 

Figure 1. Abaqus/CAE 6.11-2 Start Session Dialog Box. 
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 Once the Start Session box is exited, the Abaqus/CAE Viewport should look similar to Figure 2. 

(Please note the model tree is the series of functions listed on the left hand side of the viewport, 

while the module is the list of icons to the right of the model tree) 

 

Figure 2. Abaqus/CAE Viewport 

 To create the model geometry of the aluminum plate, a sketch of the face of the part must be 

generated. 

 Using the left mouse button, double click Parts in the model tree and the Create Part (Figure 3a) 

dialog box appears. Enter a new name for the part (PLATE), and under the Base Feature tab 

choose Shell for shape and Planar for type. Change the approximate size option to 20. The 

Create Part dialog box should look identical to Figure 3b. 

 Click Continue… and the graphics window will change to a set of gridlines.  

Model Tree 
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     Figure 3a. Create Part Dialog Box      Figure 3b. Create Part Dialog Box (PLATE) 

 

 For the first step in generating the model geometry an outline of the plate must be created. 

Click the Create Isolated Point icon    in the module. (Remember, the module is the series of 

icons to the right of the model tree) 

 At the bottom of the viewport the Pick a point – or enter X,Y: option will appear. Points will be 

entered using X,Y coordinates. Enter the X,Y coordinates of the points listed in Table 1. After 

each entry hit enter on the keyboard and the point will appear in the viewport. (Enter the points 

in the x,y format) 

Table 1. Points for Geometry 

Point X Coordinate Y Coordinate 

1 -2.5 0.75 

2 -2.0 0.75 

3 -1.5 0.75 

4 -0.75 0.75 

5 0.75 0.75 

6 1.25 0.75 

7 1.5 0.75 

8 1.5 0.5 

9 2.5 0.5 

10 2.5 -0.5 

11 1.5 -0.5 

12 1.5 -0.75 

13 1.25 -0.75 

14 0.75 -0.75 

15 -0.75 -0.75 

16 -1.5 -0.75 

17 -2.0 -0.75 

18 -2.5 -0.75 
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19 0 0 

20 -0.25 0 

21 0.25 0 

 If all of the points have been entered correctly, the viewport should look similar to Figure 4. To 

auto scale the points to fit the screen hit F6 on the computer keyboard. 

 

Figure 4. Geometry Points 

 Click the Create Lines: Connected icon  in the module, click and create lines between points 

1 & 2, 2 & 3, 3 & 4, 4 & 5, 5 & 6. After the fifth line has been created click the center scroll wheel 

on the mouse to exit the creation of this segment of lines. 

 Create lines between points 13 & 14, 14 & 15, 15 & 16, 16 & 17, 17 & 18. After the fifth line has 

been created click the center scroll wheel on the mouse to exit the creation of this segment of 

lines.  

 Next, create lines between points 8 & 9, 9 & 10, 10 & 11. After the third line has been created 

click the center scroll wheel on the mouse to exit the creation of this segment of lines.  

 Finally, create a line between points 1 & 18. Press Esc on the computer keyboard to exit the 

Create Lines: Connected tool. At this point of the sketch the geometry should look similar to 

that in Figure 5. 

X,Y Coordinates 
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Figure 5. Geometry Lines 

 The final step in drawing the plate geometry is to create a hole and two fillets. Click the Create 

Circle: Center and Perimeter  icon in the module. Using the cursor click point 19, this will 

denote the center point for the circle. Next click point 20, this will select a perimeter point for 

the circle. Press Esc on the computer keyboard to exit the Create Circle: Center and Perimeter 

tool. 

 Finally, click the Create Arc: Center and Two Endpoints icon in the module. For a center 

point the first filet click point 7. Next click point 8 to denote a start point for the arc. Finally click 

point 6 for an endpoint for the arc. Repeat the same steps to create the second filet for points 

12 (center), 13 (start), 11 (end). Press Esc on the computer keyboard to exit the Create Arc: 

Center and Two Endpoints tool.  

 The completed geometry should look similar to that in Figure 6.  
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Figure 6. Geometry Complete 

 The geometry of the plate is now complete. Click Done at the bottom of the viewport to exit the 

sketching viewport. Upon exiting the sketching viewport, the part should turn a solid grey color 

(Figure 7).  

 

Figure 7. Plate with Hole (Part Module) 
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Defining Material Properties 

 To define material properties for this model, double click on Materials in the model tree and the 

Edit Material dialog box will appear (Figure 8a). Enter a Name for the material (ALUMINUM), 

and click the Mechanical tab, highlight Elasticity and click Elastic.  Enter values of Young’s 

Modulus = 10E06 Psi, and Poisson’s Ratio = 0.3. After the material properties have been 

entered, the Edit Material dialog box should look identical to Figure 8b.  

 Click OK. 

                                     

           Figure 8a. Edit Material Dialog Box       Figure 8b. Edit Material Dialog Box (ALUMINUM) 

 Please note there is no dropdown menu or feature in Abaqus that sets specific units.  All of the 

dimensions have been input in inches; therefore the respective Young’s Modulus units should 

be entered in Psi (Pounds per square inch).  The units chosen for the definition of the material 

properties should be consistent and dictate what units should be used for the dimensions of the 

structure.  

 At this point in preprocessing, the model should be saved. Click File then click Save. Name the 

file Plate With Hole Tutorial. The file will save as a Model Database (*.cae*) file. It may be of 

interest to save the file after each section of this tutorial.  

Creating Sections 

 To create a shell section in Abaqus, double click Sections in the model tree and the Create 

Section dialog box will appear (Figure 9a). Enter a Name for the section (SHELL), and choose 

Shell under the Category Tab, and Homogeneous under the Type tab. Your Create Section 

dialog box should look identical to that in Figure 9b.  

 Click Continue…  
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                Figure 9a.  Create Section Dialog Box                Figure 9b. Create Section Dialog Box (SHELL) 

 The Edit Section dialog box will then appear where a value for the respective Shell thickness can 

be prescribed for this section.  Because only one material has been created, the Material is 

defaulted to ALUMINUM. If multiple materials had been created, the dropdown menu could be 

used to prescribe a different material to this section.  

 Under the basic tab enter 0.25 for the Shell thickness. Change the Thickness integration rule: to 

Gauss. When this is done the number of Thickness integration points will default to 3.  The Edit 

Section dialog box should look identical to that in Figure 10. 

 Click OK. 

    

Figure 10. Edit Section Dialog Box (SHELL) 
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Assigning Sections 

 Now that the shell section has been created, it can be assigned to the geometry. In the model 

tree, click the + to the left of the Parts icon, this will further expand the model tree’s options. 

Next, click the + to the left of the part called PLATE, further expanding the model tree (Figure 

11). 

  

Figure 11. Model Tree Expansion (Parts) 

 After the model tree has been expanded, double click Section Assignments. Using the cursor, 

draw a box around the whole part.  If the section has been chosen correctly the part will change 

color from grey to red (Figure 12).  

 Click Done.  

 

Figure 12. Selected Geometry 
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 The Edit Section Assignment dialog box will appear. Ensure that SHELL is selected under the 

Section option. Under the Shell offset option make sure the drop down definition is set to 

Middle surface.  The Edit Section Assignment dialog box should look identical to that in Figure 

13. 

 

Figure 13. Edit Section Assignment (SHELL) 

 Click OK. The geometry should now turn to a green color. 

 

Creating an Instance 

 Before the part will be meshed, it can be brought into the assembly. To do this task, click the + 

to the left of Assembly in the model tree. The model tree will expand and should look identical 

to Figure 14.  

 

Figure 14. Model Tree Expansion (Assembly) 

 Double click on the Instances icon in the expanded model tree. This feature will allow multiple 

parts to be brought into the assembly.  The Create Instance dialog box will appear (Figure 15). 

Under the Instance Type Option make sure to click Independent (mesh on instance). 
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Figure 15. Create Instance Dialog Box 

 Click OK. If this step was done correctly the model should turn a blue color (Figure 16). 

 

Figure 16. Instance Part 

 

Creating a Mesh 

 To create a mesh for the model geometry, expand Instances (1) in the model tree and then 

expand the PLATE-1 instance in the model tree and double click Mesh (Empty). Be sure to mesh 

in the ASSEMBLY part of the model tree and not the PARTS section. If this selection is done 

correctly, then the geometry should change color to pink. 

 The first step in creating the mesh is to partition the geometry. Click the Partition Face: Sketch 

 icon in the module. You will be prompted to click an edge or axis, click one of the edges of 

the geometry and the sketching plane will appear.  
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 Using the Create Lines: Connected  icon in the module create lines such that the geometry 

looks identical to that in Figure 17.  

 

Figure 17. Partitioned Geometry 

 Click Done. The sketching tool will automatically be exited. 

 Click Done. 

 The next step in creating a mesh is to seed the part. Since a refined mesh is desired around 

holes and cracks each edge will be meshed accordingly. Click and the Seed Edge icon  in the 

mesh module.  

 The edges listed in Figure 18 are to be seeded with a bias. Table 2 lists the edge number (1-10), 

the bias ratio, and how many elements along the length of that edge. Note, when clicking the 

edge to be seeded, click the side of the edge where the bias should be denser.  A red arrow will 

point where the mesh will be more refined.  

 When clicking an edge listed in Table 2, the Local Seeds dialog box will appear. Under the Basic 

tab, change the Method to By number and the Bias to Single. To change direction of the biased 

seeding click Flip bias. When the bias information for an edge has been entered click OK, and 

move on to the next edge listed in Table 2.  
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Figure 18.  Selected Biased Edges 

Table 2.  Biased Edges 

Edge Number Bias Ratio # of Elements 

1 3 6
2 3 6
3 3 6
4 3 6
5 3 4
6 3 4
7 3 4
8 3 4
9 3 4

10 3 4
 

 Now that all of the biased edges have been seeded, the edges shown in Figure 19 will be seeded 

with equal spacing of the nodes. Under the Basic tab in the Local Seeds dialog box, change the 

Bias option to None. Only the number of elements is to be entered for this edge seeding.  Seed 

the edges listed in Figure 19 with their respective values shown in Table 3.  

 

Figure 19. Selected Equal Edges 
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Edge Number Bias Ratio # of Elements 

11 0 4
12 0 4
13 0 4
14 0 6 

15 0 6 

16 0 6 

17 0 6
18 0 24
19 0 24
20 0 12
21 0 12
22 0 6
23 0 12
24 0 12

 

 If the part has been seeded correctly, the viewport should look similar to that in Figure 20. 

 

Figure 20. Seeded Part 

 The next step in creating the mesh is to assign mesh controls. Click the Assign Mesh Controls 

 icon in the model tree. Using the cursor draw a box around the whole geometry. If this is 

done correctly the color of the part will turn from pink to red. 

 Click Done. 

 The Mesh Controls dialog box will immediately appear. Under the Element Shape option click 

Quad. Under the Technique option click Structured. You may be prompted by an Abaqus dialog 

box, click Yes.  

 Click OK. 

 All of the regions of the model should turn a green color except for the two regions that define 

the central hole (Figure 21).  
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Figure 21. Mesh Regions 

 While the Assign Mesh Controls option is still selected hold shift on the computer keyboard and 

click the two sections that define the central hole. If this is done correctly they will turn from a 

pink to a red color.  

 Click Done.  

 The Mesh Controls dialog box will immediately appear. Under the Element Shape option click 

Quad. Under the Technique option click Structured. You will be prompted by an Abaqus dialog 

box, click Yes.  Click the Redefine Region Corners… option in the Mesh Controls dialog box. At 

the bottom of the viewport, click Select New. 

 While holding shift of the keyboard click the four nodes that join the two regions along the x-

axis (Denoted by the stars in Figure 21).  

 You will be prompted to do this procedure twice, for both the top and bottom partition of the 

model, follow the same procedure and select the same four nodes for both partitions.  

 Click Done. Click OK. 

 The part is ready to be meshed. Click the Mesh Part Instance  Icon In the module.  

 Click Yes. If the mesh has been generated properly, the part should look similar to Figure 22. 
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Figure 22. Meshed Part 

Creating a Crack 

 Now that the geometry has been meshed, a crack will be created on the part.  In the model tree, 

expand the Engineering Features by clicking the + sign. If this has been done correctly, the 

model tree should look similar to that in Figure 23. 

 

Figure 23. Model Tree Expansion (Crack) 

 Double click Engineering Features in the model tree and top toolbar of the screen will change. 

At the top toolbar click Special   and in the dropdown menu hover the cursor over Crack and 

click Assign Seam… (Figure 24). 
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Figure 24. Assign Seam Dropdown Menu 

 Click the horizontal line created in the partition to assign the line to be modeled as a seam. (This 

line is the central horizontal line located at the left side of the part). 

 Click Done. 

 Click Done. 

Creating a Step 

 A Step is where the user defines the type of loading, e.g. Static or Dynamic, and defines the 

boundary conditions, e.g. support constraints and forces. 

 In the model tree, double click the Steps (1) icon. The Create Step dialog box will appear 

(Figure 25a). Create a Name for the step called LOADING STEP. Under Procedure type choose 

General > Static, General. The Create Step dialog box should look identical to Figure 25b. 

                                                                  

                   Figure 25a. Create Step Dialog Box             Figure 25b. Create Step Dialog Box (LOADING STEP) 

 Click Continue…, and the Edit Step dialog box will immediately appear (Figure 26). 
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Figure 26. Edit Step Dialog Box 

 Click OK to accept the default values for the various options. 

Apply Constraint Boundary Conditions 

 Boundary conditions will be defined which will simulate a fixed (also known as “clamped”) beam 

at one end with a tip load.   

 Double click BCs in the model tree and the Create Boundary Condition dialog box will appear 

(Figure 27a). Create a Name for the boundary condition called FIXED, and under the Step drop 

down menu make sure to choose Initial. Under the Category option choose Mechanical, and 

choose Symmetry/Antisymmetry/Encastre under the Types for Selected Step option. The 

Create Boundary Condition dialog box should look identical to that in Figure 27b.   

                                            

             Figure 27a. Create Boundary Condition                   Figure 27b. Create Boundary Condition (FIXED) 



ABAQUS CAE BEAM TUTORIAL 19 REV 03.05.2012 

 Click Continue… 

 Click on the left vertical edge of the part. If the edge has been selected correctly it will turn a red 

color.  

 Click Done. 

 The Edit Boundary Condition dialog box will immediately appear. Click ENCASTRE 

(U1=U2=U3=UR1=UR2=UR3=0). The Edit Boundary Condition dialog box should look identical to 

that in Figure 28. 

 

Figure 28. Edit Boundary Condition Dialog Box 

 Click OK. 

Applying an Axial Load to the Structure 

 An axial load of 500 lbs will be applied on the right side of the structure. Double click Loads in 

the model tree and the create load dialog box will appear (Figure 29a). Create a Name for the 

load called AXIAL. Ensure that the Step option is set to LOADING STEP and that the Category is 

set to Mechanical. For the Types for Selected step option choose Shell edge load. The Create 

Load dialog box should look similar to Figure 29b. 
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                                   Figure 29a. Create Load                                  Figure 29b. Create Load (AXIAL) 

 Click Continue… 

 Click the right vertical edge of the part.  

 Click Done. The Edit Load dialog box will immediately appear (Figure 30a). Under Magnitude 

enter -500, under the Traction is defined per unit dropdown menu choose undeformed area. 

The Edit Load dialog box should look similar to Figure 30b. 

                                                          

                             Figure 30a. Edit Load Dialog Box                  Figure 30b. Edit Load Dialog Box (AXIAL) 

 Click OK. If this has been done correctly, small purple arrows will appear on that edge in the 

direction of the loading.  

Creating a Job 

 To create a job for this model, double click the Jobs icon in the model tree. Up to this point, you 

have been preprocessing the model.  A job will take the input file created by the preprocessor 

and process the model, i.e. perform the analysis.  In the Create Job dialog box, create a Name 
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for this job called AXIAL. Blank spaces are not allowed in a job name.  Thus the use of the 

underline in the name.  The Create Job dialog box should look identical to that in Figure 31. 

 

Figure 31. Create Job Dialog Box (AXIAL) 

 Click Continue… 

 The Edit Job dialog box will immediately appear (Figure 32).  

 

Figure 32. Edit Job Dialog Box (AXIAL) 

 Accept the default values and click OK. 

Setting the Work Directory 

 To ensure that the input files write to the correct folder, setting the work directory must be 

accomplished. At the top of the screen, click File and in the dropdown menu click Set Work 

Directory… (Figure 33). 
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Figure 33. Set Work Directory 

 The Set Work Directory screen will immediately appear (Figure 34). Click Select… and use 

standard Windows practice to select (and possibly create) a subdirectory.  

 

Figure 34. Set Work Directory (FOLDERS) 

 Click OK.  

 Click OK. 

Writing the Input File (.inp) 

 To write the input file of the job that was created, first click the + next to the Jobs (1) icon in the 

model tree. 

 Right click the job called AXIAL and click the Write Input option. This choice will write an input 

file (.inp) of this model to the work directory.  

 It may be helpful to go to the folder on the computer to which the work directory is set to 

ensure that the input file was written there.  
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Model Analysis (ABAQUS Command)   

 Method #1 

 Go to the Start Menu and open Abaqus Command 

 Abaqus is set to a default directory (Example K:\>). To change directories in the Abaqus 

Command type the directory of choice followed by a colon (C:) then hit Enter. 

 To access a specific directory within that drive type cd followed by the specific folder name in 

that directory (e.g., cd APPLIED STRENGTHS T.A) then hit Enter. 

 Now that the correct directory has been sourced in the command window type abaqus inter 

j=AXIAL  and then hit enter. 

 If the job has completed successfully the Abaqus prompt should look similar to Figure 35. 

 

Figure 35.  Abaqus Command Prompt (COMPLETED) 

 Method #2 

 An alternative method for submitting an *.inp file for processing by Abawus can be 

accomplished with Abaqus/CAE. 

 Right click the job called AXIAL and click the Submit option. 

 If you see a warning (Figure 36) : 

 
Figure 36. Abaqus Warning 
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Click OK.  The intent of this warning is to prevent the user from accidentally overwriting a 

previously completed analysis with the same name. 

 The model will now be submitted for analysis by Abaqus and the progress can be viewed in the 

status window at the bottom of the screen (Figure 37). 

 
Figure 37. Status Window 

Postprocessing using Abaqus/CAE 

 After the analysis has successfully completed in the Abaqus Command window using Method #1 

or using Method #2, return to view the Abaqus/CAE viewport.  

 Because the last step of creating the model was to create a job/write (and possibly submit) an 

input file, the AXIAL (Completed) job should still be highlighted in Abaqus/CAE model tree. Right 

click the AXIAL (Completed) job and then click Results.  

 If this selection was done correctly, the model should turn to a green color and the geometry 

will have rotated to an isometric view (Figure 38). 

 

Figure 38. Analysis Results Isometric View 

 To rotate the model back into the X Y plane for viewing, click View in the toolbar at the top of 

the screen. Next, Click Toolbars and make sure the option Views has a check mark to the left of 

it.  If not, then click it.  

 The Views toolbar will appear (Figure 39), and the Apply Front View button can be clicked to 

view the model in the X Y plane.   
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Figure 39. Views Toolbar 

 To view the deformed shape of the model, click the Plot Contours on Deformed Shape icon   

in the Visualization module. The model should look similar to that in Figure 40. 

 

Figure 40. Deformed Shape (AXIAL) 

Conclusion 

 Save the file by doing either File > Save or clicking the disk icon. 

 

 
 Close Abaqus/CAE:  File > Exit or Ctrl+Q 

 This completes the Finite Element Analysis of a Plate with Stress Concentrations Tutorial.  

 

 




